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Fig. 1.6 Mainframe Computer 
 

5) Super Computers processing capabilities lies in the range of GIPS2, word length 
64-128 or may be in 256 or so. Memory capacity in some gigabytes or in 
terabytes and storage capacity in pixabytes. It contains a number of CPU’s, which 
operate in parallel to make it faster, giving them their speed through parallel 
processing. They are used for weather forecasting, weapons research and 
development, rocketing, aerodynamics, atomic, nuclear and plasma physics.  
Supercomputers have limited use and limited market because of their very high 
price.  

 

 
 

Fig.1.7: Super Computer 
 
They are being used at some research centers and government being used at some 
research centers and government tasks. Examples of users of these computers are 
governmental agencies, such as the IRS, the National Weather Service, and the 
National Defense Agency. Also, they are used in the making of movies, space 
exploration, and the design of many other machines. Supercomputers are used for 
tasks that require mammoth data manipulation.  
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b) It converts these instructions and data in computer acceptable form. 
c) It supplies the converted instructions and data to computer system for further 
processing. 
 
Input Devices are used to input data, information and instructions into the RAM.  We 
may classify these devices into the following two broad categories: 
 

• Basic Input Devices 
• Special Input Devices 

 
Basic Input Devices 
The input devices, which have now days become essential to operate a PC, may be called 
as Basic Input Devices.  These devices are always required for basic input operations.  
These devices include Keyboard and Mouse.  

Special Input Devices 
The input devices, which are not essential to operate a PC, are called as Special Input 
Devices. These devices are used for various special purposes and are generally not 
required for basic input operations.  These devices include Trackball, Light Pen, Touch 
Screen, Joystick, Digitizer, Scanner, OMR, OCR, Bar Code Reader, MICR and Voice 
Input Devices. 
 
B) Output Devices 
An Output unit performs following functions: 
 
a) It accepts the results produced by a computer, which are in coded form and hence, we 
cannot easily understand them. 
b) It converts these coded results to human acceptable (readable) form. 
c) It supplies the converted results to outside world. 
  
Output devices are hardware components, which are used to display or print the 
processed information.  We are discussing below the structure, working and uses of the 
common output devices: 
 
Monitor 
Visual Display Unit (VDU) commonly called, as monitor is the main 
output device of a computer. It consists of a Cathode Ray Tube (CRT), 
which displays characters as an output.  It forms images from tiny dots, 
called pixels that are arranged in a rectangular form.  The sharpness of the  
image (screen resolution) depends upon the number of pixels. 
 
Printer 
Printer is the most important output device, which is used to print information on paper. 
Printers are essential for getting output of any computer-based application. 
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2.1.1 Relation between Hardware and Software 
For a computer to produce useful output its hardware and software must work together. 
Nothing useful can be done with the hardware on its own, and software cannot be utilized 
without supporting hardware. 
 
To take an analogy, a cassette player and its cassettes purchased from the market are 
hardware. However, the songs recorded on the cassettes are its software. To listen to a 
song, that song has to be recorded on one of the cassettes first, which is then mounted on 
the cassette player and played. Similarly, to get a job done by a computer, the 
corresponding software has to be loaded in the hardware first and then executed. 
 
Following important points regarding the relationship between hardware and software are 
brought out by this analogy: 
 
1. Both hardware and software are necessary for a computer to do useful job. Both are 

complementary to each other. 
2. Same hardware can be loaded with different software to make a computer perform 

different types of jobs just as different songs can be played using the same cassette 
player.  

3. Except for upgrades (like increasing main memory and hard disk capacities, or adding 
speakers, modems, etc.); hardware is normally a one- time expense, whereas software 
is a continuing expense. Like we buy new cassettes for newly released songs or for 
songs whose cassettes, we do not have, we buy, new software to be run on the same 
hardware as and when need arises, or funds become available. 

 
--------------------------------------------------------------------------------------------------------- 
2.2 TYPES OF SOFTWARE 
--------------------------------------------------------------------------------------------------------- 
Software is broadly classified into following two types: 

• System Software 
• Application Software 

 
2.2.1 System Software 
Software that is required to control the working of hardware and aid in effective execution 
of a general user's applications are called System Software.  This software performs a 
variety of functions like file editing, storage management, resource accounting, 1/0 
management, database management, etc.  Some of the examples of system software are 
DOS (Disk Operating System), Windows, BASIC, COBOL and PC TOOLS.  This 
software is developed by System Programmers. 
 

Types of System Software 
System software can be further categorized into following three types: 

• System Management Software (Operating Systems, DBMSS, Operating 
Environments) 
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Fig 2.2 Software Development Life Cycle 

 
 
Importance of Software Development Life Cycle 
Because software can be very difficult and complex. We need the SDLC as a framework to 
guide the development to make it more systematic and efficient.  
 
We will be able to tell how long it will take to complete the project, to test and deploy. Not 
only that, you'll have an easier time debugging and finding flaws in the software program 
or make enhancement to it. 
--------------------------------------------------------------------------------------------------------- 
2.4 INTRODUCTION TO ALGORITHM 
--------------------------------------------------------------------------------------------------------- 
Planning a program involves defining its logic (the correct sequence of instructions needed 
to solve the problem at hand). The term Algorithm refers to the logic of a program. It is a 
step – by – step description of how to arrive at a solution. To a given problem. It is defined 
as a sequence of instructions that when executed in the specified sequence, the desired 
results are obtained. In order to qualify as an algorithm, a sequence of instructions must 
possess the following characteristics: 

1. Each instruction should be precise and unambiguous. 

2. Each instruction should be executed in a finite time. 

3. One or more instructions should not be repeated infinitely. This ensures that the 
algorithm will ultimately terminate. 

4. After executing the instructions (when the algorithm terminates), the desired results 
are obtained. 
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Therefore, in simple terms, we can say that an algorithm is a procedure to accomplish a 
specific task. It is the idea behind any computer program. To be interesting, an algorithm 
has to solve a general, well-specified problem. An algorithmic problem is specified by 
describing the complete set of instances it must work on and what properties the output 
must have as a result of running on one of these instances. This distinction between a 
problem and an instance of a problem is fundamental. To gain insight into algorithms, let 
us consider a simple example. 
 
Example: There are 50 students in a class who appeared in their final examination. Their 
mark sheets have been given to you. Write an algorithm to calculate and print the total 
number of students who passed in first division. 
 
Algorithm: 
 
Step 1: Initialize TOTAL FIRST DIVISION and TOTAL MARKSHEETS CHECKED to 
zero. 
 
Step 2: Take the mark sheet of the next student. 
 
Step 3: Check the division column of the mark sheet to see if it is FIRST. If no, go to step 
5. 
 
Step 4: Add 1 to TOTAL FIRST DIVISION. 
 
Step 5: Add 1 to TOTAL MARKSHEETS CHECKED. 
 
Step 6: Is TOTAL MARKSHEETS CHECKED = 50? If no, go to step 2. 
 
Step 7: Print TOTAL \FIRST DIVISION. 
 
Step 8: Stop. 
 
It must be clear to you from this example that even for every simple problems, the 
development of algorithms is not as simple as it might initially appear and requires some 
thinking. It may also be noted from the given example that in order to solve a given 
problem, each and every instruction must be strictly carried out in a particular sequence. It 
is this fact, which a beginner to problem solving by computers finds difficult to appreciate. 
 
--------------------------------------------------------------------------------------------------------- 
2.5 FLOWCHARTS 
--------------------------------------------------------------------------------------------------------- 
A Flowchart is a pictorial representation of an algorithm. Programmers often use it as a 
program – planning tool for visually organizing a sequence of steps necessary to solve a 
problem using a computer. It uses boxes of different shapes to denote different types of 
instructions. The actual instructions are written within these boxes using clear and concise 
statements. Solid lines having arrow marks connect these boxes to indicate the flow of 
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--------------------------------------------------------------------------------------------------------- 
OPERATING SYSTEMS  
--------------------------------------------------------------------------------------------------------- 

Structure 
3.1 Introduction 
 3.1.1 Layers of Operating System  
 3.1.2 Functions of Operating Systems 
 3.1.3 Characteristics of an Operating System 
 3.1.4 Measuring System Performance 
 
3.2 Evolution of Operating Systems 
 3.2.1 Serial Processing 
 3.2.2 Batch Processing 
 3.2.3 Multiprogramming  
 
3.3 Types of Operating System  
 3.1 Batch Processing Operating Systems.  
 3.3.2 Time Sharing Operating Systems 
 3.3.3 Real Time Operating Systems 
 
3.4 Operating System Techniques 
 3.4.1 Multiprogramming 
 3.4.2 Multiprocessing 
 3.4.3 Multitasking 
 3.5.4 Multithreading  
 
3.5 Some Popular Operating Systems 
 3.5.1 Disk Operating System 
 3.5.2 UNIX 
 3.5.3 Linux 
 3.5.4 Microsoft Windows  
 3.5.5 Microsoft Windows NT 
 
3.6 Review Questions 
--------------------------------------------------------------------------------------------------------- 
3.1 INTRODUCTION 
--------------------------------------------------------------------------------------------------------- 
What is human body without life giving Oxygen, the same is the case of a computer, its 
existence is immaterial, without an operating system, such is the importance of the 
Operating System. Operating System falls under the category of System software. The goal 
of this unit is to introduce the concept related to operating system and what is the function 
of operating system. 
 
The Operating System is not the command interpreter alone, as people perceive. The 
Operating System is the program that must be running all the time, and cannot be replaced 
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3.1.3 Characteristics of an Operating System 
Let us try to identify the main characteristics of an operating system: 
 

• Concurrency: being able to handle events as they occur and executing multiple 
tasks in parallel; 

• Sharing the resourced for a number of reasons: 
1. Cost 
2. Using the work of others 
3. Sharing data: use the same data in several different programs possibly 

used by several different users. 
• Removing redundancy; 
• Long-term storage of information (privacy, integrity, security); 
• Non determinacy: an operating system must be able to handle events occurring 

in an unpredictable order. 
 

3.1.4 Measuring System Performance 
Efficiency of an operating system and overall performance of a computer system are 
measured usually in terms of the following parameters: 
 

1. Throughput: Throughput is the amount of work that a system is able to do per unit 
time. It is measured as the number of jobs (processes) completed by the system per 
unit time. For example, if a system is able to complete n processes in t seconds, its 
throughput is n/t processes per second during that interval. Throughput is measured 
normally in processes per hour. Note that the throughput of a system does not 
depend on its jobs processing efficiency only, but also on the number of jobs 
processed. For long process, throughput of a system may be one process/hour; 
whereas for short processes, it may be 100 processes /hour for the same system. 

2. Turnaround time: From the point of view of an individual user, an important 
criterion is how long it takes a system to complete a job submitted by him/her. 
Turnaround time is the interval between the time of submission of a job to the 
system for processing to the time of completion of the job. Although, higher 
throughput is desirable from the pointy of view of overall system performance, 
individual users are more interested in better turnaround time for their jobs. 

3. Response time: Turnaround time is not a suitable measure for interactive systems 
because in such a system a process can produce some output early during its 
execution and can continue executing while previous results are being output to the 
user. Hence, another measure used in case of interactive systems is response time. It 
is the interval between the time of submission of a job to the system for processing 
to the time of the system producing the first response for the job. In any computer 
system, it is desirable to maximize throughput and minimize turnaround time and 
response time. 
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Multiprogramming has traditionally been employed to increase the resource utilization of a 
computer system and to support multiple simultaneously interactive users (terminals). 
Compared to operating system which supports only sequential execution, 
multiprogramming system requires some form of CPU and memory management strategies  
 

 
 

Figure 3.6: Multiprogramming 
 

--------------------------------------------------------------------------------------------------------- 
3.3 TYPES OF OPERATING SYSTEM  
--------------------------------------------------------------------------------------------------------- 
As computers have progressed and developed so have the types of operating systems.  
Many types of operating systems are available for computers, which can be divided into the 
following two broad categories - 

 
(a) Single-user operating systems. 
(b) Multi-user operating systems. 
 
(a) Single-user operating systems: These operating systems are used for mainly 
computers having only one terminal (stand-alone PCs).  MS DOS (Microsoft Disk 
Operating System) and PC DOS (Personal Computer Disk Operating System) are the two 
important single user operating systems.  Both systems are almost identical and are simply 
called DOS.  OS/2 and Windows NT are other popular single-user multi-tasking operating 
systems for microcomputers. 
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simultaneously. Multiprogramming feature allows multiple user programs to reside 
simultaneously in main memory, and special CPU scheduling algorithm allocates a short 
period of CPU time one-by-one to each user process (from the first one to the last one, and 
then again beginning from the first one). The short period during which a user process gets 
to use CPU is known as time slice, time slot, or quantum, and is typically of the order of 
10 to 100 milliseconds. Hence, when CPU is allocated to a user process, it uses the CPU 
until the allotted time slice expires (system's clock sends an interrupt signal to CPU after 
every time slice), or it needs to perform some I/O operation, or it completes its execution 
during this period. Notice that CPU is taken away from a running process when the allotted 
time slice expires. Figure 3.7 shows the process state diagram of a time-sharing system  
 

 
 

 
Figure 3.7 Process state diagrams for a time-sharing system. 

In this environment a computer provides computing services to several or many users 
concurrently on-line. Here, the various users are sharing the central processor, the memory, 
and other resources of the computer system in a manner facilitated, controlled, and 
monitored by the operating system. The user, in this environment, has nearly full 
interaction with the program during its execution, and the computer’s response time may be 
expected to be no more than a few second. 

Advantages of Time-sharing Systems: Although time-sharing systems are complex to 
design, they provide the following advantages to their users: 
 
1. Reduces CPU idle time. A user's thinking and typing speed is much slower than a 
computer's processing speed. Hence, during interactive usage of a system, while a user is 
engaged in thinking or typing his / her input, a time-sharing system services many other 
users. Hence, time-sharing systems help in reducing CPU idle time and, in turn, provide 
increased system throughput. 
 
2. Provides advantages of quick response time. The special CPU scheduling algorithm 
used in time sharing systems ensures quick response time to all users. This feature helps in 
improving programmers' efficiency by making interactive programming and debugging 
much simpler and quicker. Multiple programmers can work simultaneously for writing, 
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testing, and debugging their programs, or for trying out various approaches to a problem 
solving. 
 
3. Offers good computing facility to small users. Small users can gain direct access to 
more sophisticated hardware and software than they could otherwise justify or afford. In 
time-sharing systems, they merely pay a fee for resources used and are relieved of 
hardware, software, and personnel problems associated with acquiring and maintaining 
their own installation. 
 
Multitasking Operating Systems: Multi-tasking operating systems are now very 
common. They enable the computer to run more than one piece of software at the same 
time. It is quite common to sit at your computer and have a word-processor open and 
running, as well as an Internet browser, and an audio CD player all at the same time. 

The operating system allows you to switch between the applications and even transfer data 
between them (for example, it helps you to copy a picture from an internet site shown on 
your browser application and paste it into your DTP application). 

Multitasking Operating systems allow multiple software processes to be run at the same 
time. Operating systems that would fall into this category are: 

• System 7.x 
• System 8.x 
• UNIX 
• Windows 2000 
• Windows 95 
• Windows 98 
• Windows NT 4.0 

Multitasking operating systems allow a user to do more than one thing at the same time. 
 
Multi-user Operating Systems: Multi-user operating systems are used on networks of 
computers and allow many different users to access the same data and application programs 
on the same network. It also allows users to communicate with each other. 
There are many different types of Network Operating System, each one suited to a 
different. 
 
Multi - User - Allows multiple users to utilize the computer and run programs at the same 
time. Operating systems that would fall into this category are: 

• System 7.x 
• System 8.x 
• UNIX 
• Windows 2000 
• Windows 3.1x 
• Windows 95 
• Windows 98 
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3.5.4 Microsoft Windows  
 
It is a series of software operating systems and graphical user interfaces produced by 
Microsoft. It was developed by Microsoft to overcome the limitations of its own MS-DOS 
operating system. Microsoft first introduced an operating environment named Windows in 
November 1985 as an add-on to MS-DOS in response to the growing interest in graphical 
user interfaces (GUIs). Microsoft Windows came to dominate the world's personal 
computer market, overtaking Mac OS, which had been introduced previously. The most 
recent client version of Windows is Windows Vista; the most recent server version is 
Windows Server 2008. Vista's successor, Windows 7 (currently a release candidate), It is a 
family of operating systems for personal computers. Windows dominates the personal 
computer world, running, by some estimates, on 90% of all personal computers. The 
remaining 10% are mostly Macintosh computers. Like the Macintosh operating 
environment, Windows provides a graphical user interface (GUI), virtual memory 
management, multitasking, and support for many peripheral devices. Main Features of 
Microsoft Windows are as follows: 
 
Its native interface is a GUI. Hence, for a new user it is easier to learn and use a computer 
system. 
 
A Microsoft window was designed to be not just an operating system but also a complete 
operating environment. That is, all its programs conform to a standard way of working. For 
example, a Microsoft Windows word processor works similarly the way a Microsoft 
windows spreadsheet (or any other type of Windows program) works. This means that 
experience gained by learning one Windows program is useful while using any other 
Microsoft Windows program. 
 
It is single- user, multitasking operating system. That is, a user may run more than one 
program at a time. For example, while editing a file in foreground, a sorting job can be run 
in background. Monitor’s screen can be portioned into multiple windows and progress of 
different programs can be viewed on different windows. 
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are also known as peripheral interchange programs (PIP) since they are used often to 
copy a file from one peripheral device to another. 
 
Printing: A file printing utility is used to print a file on a printer to produce hard copy of 
its contents. Printing utilities often provide facility to print file contents in different 
formats. They often provide some selection and editing facilities to enable printing of parts 
of files (such as specified number of records and only certain fields of records). Special 
printing facilities are often provided to print files that contain program instructions rather 
than data. 
 
Maintenance: A file maintenance utility is used to copy data from one or more files to a 
new file selectively, or to update a file's contents selectively. For example, a file 
maintenance utility may provide features to combine data from more than one file into a 
single file, delete records in a file identified by record key values or record count, and 
select specific fields of records to be copied from an existing file to a new file. 
 
--------------------------------------------------------------------------------------------------------- 
4.3 DATABASE MANAGEMENT SYSTEM 
--------------------------------------------------------------------------------------------------------- 
 
4.3.1 Data Base  
A database can be defined in various ways, for example 
 

• A database is a collection of structured data. The structure of the data is 
independent of any particular application. 

 
• A database is a file of data; structured  in such a way  that it may serve a  

number of applications  without its structure being  dictated by any one of those 
applications, the concept being that programs are written round the database 
rather than files being structured to meet the needs of  a particular programs 

 
The centre of any information system is its database, which is a collection of the data 
resources of an organization designed to meet the requirements of the company for 
processing and retrieving information by decision makers. One important use of database is 
to target more precisely marketing efforts. In the USA the later trend in management 
information systems is the executive information system which is used by senior managers. 
 
A database can be termed as a repository of data. A collection of actual data which 
constitutes the information regarding an organization is stored in a database. For example, 
there are 1000 students in a college & we have to store their personal details, marks details 
etc., these details will be recorded in a database. 
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matching are often indexed in order to speed up the process and the data can be retrieved 
and manipulated in a number of ways without the need to reorganize the original database 
tables. Working under the assumption that file systems (which often use the hierarchical or 
network models) are not considered databases, the relational database model is the most 
commonly used system today. While the concepts behind hierarchical and network 
database models are older than that of the relational model, the latter was in fact the first 
one to be formally defined.  

Properties of Relational Tables: 
 Values Are Atomic  
 Each Row is Unique  
 Column Values Are of the Same Kind  
 The Sequence of Columns is Insignificant  
 The Sequence of Rows is Insignificant  
 Each Column Has a Unique Name  

 

 
 

Fig 4.10 Relational Model 

4.3.4.4 Object-Oriented Model 
After the relational DBMS soared to popularity, the most recent development in DMBS 
technology came in the form of the object-oriented database model, which offers more 
flexibility than the hierarchical, network and relational models put together. Under this 
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languages (data definition language, data manipulation language, query language) that are 
part of database management system. With popularity of object-oriented paradigm, use of 
object-oriented programming languages for implementing applications has become a 
common practice. However, database languages used in database management systems for 
conventional database models do not use object-oriented concepts for implementing 
applications. This mismatch between object-oriented programming languages and database 
languages used in database management systems for conventional database models makes 
database implementation of many applications inconvenient. 
 
Object-oriented database model was introduced to overcome these shortcomings of 
conventional database models. An object-oriented database is a collection of objects 
whose behavior, state, and relationships are defined in accordance with object-oriented 
concepts (such as object, class, class hierarchy, etc.). An object-oriented database 
management system allows definition and manipulation of an object-oriented database. 
 
Figure 4.11 shows an example of an object-oriented database structure. Class Vehicle is 
root of a class composition hierarchy including classes Vehiclespecs, Company, and 
Employee. Class Vehicle is also root of a class hierarchy involving classes Two Wheeler 
and Four Wheeler. Class Company is, in turn, root of a class hierarchy with subclasses 
Domestic Company and Foreign Company. It is also root of a class-composition hierarchy 
involving class Employee. 
            

 
Fig 4.11 An example of an object-oriented database structure 
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the standard Structured Query Language used in many DBMSs. 
A query language can be easily learnt by a non-programmer. This enables normal users of a 
database to obtain desired information from the database without the help of any 
programmer 
 
Report Generator 
A report is presentation of information extracted from a database. Report generators 
enable users of a database to design the layout of a report in desired format. This means 
that that users can specify proper spacing between data items to be presented in a report, 
and can also include suitable report titles and subtitles, column heading, page numbers, 
separation lines, and other elements making a report more readable and presentable. Report 
generators can also be instructed to perform arithmetic operations (such as calculating 
subtotals and totals) on data found in numeric fields to make a report more meaningful and 
useful. 
 
4.3.6 Creating and Using a Database 
In this section, we will take a closer look at how a database is created and used. Large 
databases on large computer systems are created and maintained normally by professional 
programmers. Users of these databases, however, need not be programmers. They can be 
used easily by non-programmers to access data and produce reports. On the other hand, 
many database management systems, designed for personal computer systems, enable 
nonprogrammers to not only use, but even tolerate their own databases. These databases 
normally are simple in structure and small in size. 
 
4.3.6.1 Creating a Database 
Creation of a database is a three steps process: 
1. Defining its structure (schema) 
2. Designing forms (custom screens) for displaying and entering data  
3. Entering data into it  
These steps are described below 
 
Schema Definition 
First thing we do to set up a database is to define its structure (schema definition). This is 
done by identifying characteristics of each field in it. A good way to begin defining schema 
of a database is to list down on paper all fields to be included in the database, and then to 
determine the name, type, and size of each field. This information is then captured into the 
system by using a tool called schema builder. Schema builder enables a user to define a 
database schema interactively by prompting the user to enter name, type, size, etc. for each 
field. 
 
While defining the schema of a database, it is important to consider possible future needs 
and needs of all types of users of the database. That is, all possible fields that may be 
needed should be included in database structure while defining it. Although it is possible to 
modify database structure at any time, making such modifications is a time-consuming 
process. Hence, it is always better to carefully design a database in first instance, and 
minimize need to modify its structure later. 
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4.3.6.3 Searching for Desired Information 
 
A database management system enables its users to quickly search for desired information 
from large volume of data stored in a database with great ease. Features supported 
commonly in modem database systems for this are: 
 

1. Find command 
2. Query language 
3. Query by Example (QBE) 
 

These features are described below. 
 
Find Command 
Find command is used for simple database queries, like searching for records having a 
particular string pattern in a field. For example, in employee database created by using the 
form .of figure 4.10, Find command may be used to list records of all employees whose last 
name is "SINHA". Similarly, it may be used to list records of all employees who belong to 
the city of "PUNE". 
 
To use Find, a user has to type the string pattern to be searched and then has to indicate 
which field to search in. For instance, in the example above, user has to type "SINHA" and 
indicate that this string has to be searched in the "LAST NAME" field. User can specify 
either a single field or all fields. 
 
Find command cannot be used for creating an elaborate set of criteria for complex queries. 
Furthermore, it can operate only on one table at a time, and a user cannot save a specified 
criterion for future use. 
 
Query Language 
For handling complex queries, all database systems support a query language. Most of 
these query languages conform to the SQL standard. In SQL, a user has to specify criteria 
for search along with the fields and table (or tables) with which to work with. Criteria for 
search can be built by using relational operators (= [equal to], > [greater than], < [less 
than], and combinations of these operators), and logical operators (AND, OR, and NOT). 
For example, to list names of all employees whose last name starts with letter "S", who 
belong to "PUNE", and whose age is more than 40 years, SQL query looks as follows: 
 
SELECT [LAST NAME], [FIRST NAME], [MIDDLE NAME]  
FROM Employee 
 
WHERE ([LAST NAME] = "S...”) AND (CITY = "PUNE") AND ([AGE> 40)) 
 
Keywords SELECT, FROM, and WHERE tell SQL engine how to interpret each part of 
the query statement. SELECT keyword tells SQL which fields are to be displayed for 
records that match the criteria. FROM keyword tells SQL which table(s) to work with. 
WHERE keyword tells SQL the criteria for selecting records (search criteria). Brackets [...] 
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3. Full-Duplex 
When signals are free to travel in both directions over a medium simultaneously, the 
transmission is considered full duplex. Full duplex may also be called bi-directional 
transmission or sometimes, simply duplex. When you call a friend on the telephone, your 
connection is an example of a full-duplex transmission, because your voice signals can be 
transmitted to your friend at the same time your friend’s voice signals are transmitted in the 
opposite direction to you. In other words, both of you can talk and hear each other 
simultaneously. 
 
Full-duplex transmission is also used on data networks. For example, modern Ethernet 
networks use full-duplex. In this situation, full-duplex transmission uses multiple channels 
on the same medium. A channel is a distinct communication path between two or more 
nodes, much as a lane is a distinct transportation path on a freeway. Channels may be 
separated either logically or physically.  
An example of physically separate channels occurs when one wire within a network cable 
is be used for transmission while another wire is used for reception. In this example, while 
each separate wire in the medium allows half-duplex transmission, when combined in a 
cable they form a medium that provides full-duplex transmission. Full-duplex capability 
increases the speed with which data can travel over a network. In some cases—for 
example, telephone service over the Internet—full-duplex data networks are a requirement. 
Many network devices, such as modems and NICs, allow you to specify whether the device 
should use half- or full-duplex communication. It’s important to know what type of 
transmission a network supports before installing network devices on that network. If you 
configure a computer’s NIC to use full duplex while the rest of the network is using half-
duplex, 
 
For example, computer will not be able to communicate on the network. 
 
 

 
 

Fig 5.3 Modes of Data Transmission 
 
5.2.2 Transmission Basics 
In data networking, the term transmission has two meanings. First, it can refer to the 
process of issuing data signals on a medium. It can also refer to the progress of data signals 
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clocking scheme. Data rate is measured in bits per second (bps). Also known as hertz or 
baud, this rate is sometimes called baud rate. Encoding data in a digital signal can be 
done using several encoding types. The different encoding types can be described as either 
state-transition encoding or current-state encoding. State-transition encoding uses a change 
(or lack of a change) in a signal to represent a data value. One way this is done is to let a 
change in voltage represent a 1. Whenever the voltage changes this is translated to a 1; if 
the voltage remains the same, the value is a 0. State-transition could also allow that a 
change in voltage represents a specific value. When the voltages changes from high to low 
this represents a 1, while a change from low to high represents a 0. 
 

 
 

Fig 5.4 Analog Signal 
 

 

 
 
 

Fig 5.5 Digital Signal 
 

Data rate: This is the rate, in bits per second (bps), at which data can be communicated.  
Bandwidth: This is the maximum bandwidth of the transmitted signal as constrained by 
the nature of the transmission medium or transmission channel, expressed in cycles per 
second, or hertz (Hz). 
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of its reliability, fiber is currently used primarily as a cable that connects the many 
segments of a network. Experts predict, however, that it will replace UTP as the primary 
means of bringing data to the desktop within the next decade. Fiber-optic cable provides 
the benefits of nearly unlimited throughput, very high resistance to noise, and excellent 
security. Because fiber does not conduct electricity like copper wire, it does not emit a 
current. As a result, the signals it carries stay within the fiber and cannot easily be picked 
up except at the destination node. Copper, on the other hand, generates   signal that can be 
monitored by taps into the network. Fiber can also carry signals for longer distances than 
can coax or twisted-pair cable. In addition, you can use longer lengths of fiber with fewer 
repeaters than on a copper-based network. Finally, fiber is widely accepted by the high-
speed networking industry. Thus, industry groups are establishing standards to ensure that 
fiber-networking equipment from multiple manufacturers can be integrated without 
difficulty. 
 

 
 

Fig 5.9 Single-mode and multimode fiber-optic cables 
 
The most significant drawback to the use of fiber is its high cost. Another disadvantage is 
that fiber can transmit data in only one direction at a time; to overcome this drawback, each 
cable must contain two strands—one to send data and one to receive it. Finally, unlike 
copper wiring, fiber is difficult to splice, which means quickly repairing a cable in the field 
(given little time or resources) is difficult if not impossible.  
 
5.3.2 Unbounded Media 
Unbounded, or wireless, media does not use any physical connectors between the two 
devices communicating. Usually the transmission is sent through the atmosphere, but 
sometimes it can be just across a room. Wireless media is used when a physical obstruction 
or distance blocks the use of normal cable media. Following are the types of unbounded 
media: 
1. Radio Waves 

 i. Short-wave 
ii. Very-high frequency (VHF) television and radio 

  iii. Ultra-high frequency (UHF) television and radio Micro waves  
2. Microwaves 
  i. Terrestrial Microwaves 
  ii. Satellite Microwaves 
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Metropolitan Area Network (MAN)  
 
A Metropolitan Area Network is a system of LANs connected throughout a city or 
metropolitan area. A metropolitan area network (MAN) is a network that connects two or 
more local area networks or campus area networks together but does not extend beyond the 
boundaries of the immediate town/city. Routers, switches and hubs are connected to create 
a metropolitan area network.  MANs have the requirement of using telecommunication 
media such as voice channels or data channels. Branch offices are connected to head 
offices through MANs. Examples of organizations that use MANs are universities and 
colleges, grocery chains, and banks.  
 
Location: Separate buildings distributed throughout a city. MAN takes over the rein in 
hand where LAN is not optimal feasible both technical and financially.  
 

 
 

Fig 6.3 MAN 
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Fig 6.9 Tree Topology 

Disadvantages of Tree Topology  
1. In a Network Topology the length of the network depends on the type of cable that is 
being used.  
2. The Tree Topology network is entirely dependant on the trunk which is the main 
backbone of the network. If that has to fail then the entire network would fail.  
3. Since the Tree Topology network is big it is difficult to configure and can get 
complicated after a certain point.  
 
Mesh Topology: Mesh topologies involve the concept of routes. Unlike each of the 
previous topologies, messages sent on a mesh network can take any of several possible 
paths from source to destination. (Recall that even in a ring, although two cable paths exist, 
messages can only travel in one direction.) Some WANs, most notably the Internet, employ 
mesh routing.  
 
A mesh network in which every device connects to every other is called a full mesh. As 
shown in the Fig 6.10 below, partial mesh networks also exist in which some devices 
connect only indirectly to others.  

Benefits of Mesh Topology 
1. Provides redundant paths between devices. 
2. The network can be expanded without disruption to current users. 
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6.4.3 Need for Protocol Architecture 
When any two computer based entities wish to exchange data there must exist more than 
just a physical data path between the two communicating devices. There has to be some 
amount of co-operation between the two devices to enable the data transfer to take place. 
Some typical tasks that need to be performed for the data transfer to take place are: 
 

i. The source system must set up the communication path or inform a remote network 
of the identity of the system it wishes to communicate with. 

 
ii. The source system must determine whether the remote system is ready to accept 

data. 
 
iii. The file transfer application on the source system must make sure that the file 

management program within the remote system is ready to accept the data from the 
source. 

 
iv. If there is any incompatibility between the two system's file formats, one of the 

systems must perform a format translation. 
 

v. If data are lost, there must be some recovery system. 
 
vi. When the data transfer is complete, the systems must inform each other of their 

readiness to break the connection. 
 
vii. The tasks described above are a highly simplified view of the process that actually 

takes place and the logic to implement this co-operation is too complex to be 
installed as a single module. Instead, this logic is broken down into a set of sub-
tasks, each of which is implemented separately. 

 
viii. In protocol architecture, the logic modules are arranged in a vertical stack. Each 

layer of this stack performs a subset of the entire logic necessary to communicate 
with a remote system. Layers should be designed so that changes in one layer do 
not affect any higher or lower layers. 

 
ix. This stack of logic modules must be implemented in both of the machines that wish 

to communicate. Communication is achieved by corresponding, or peer levels in 
both machines communicating with each other. Each of these peer levels 
communicate according to a set of rules or conventions that are known as a 
protocol. 
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Method 1: Opening a document from desktop 
Click at the Start button.  Point at 'Open Office Document and click it . Alternatively, click 
at the option 'Open Office Document’ of the Office shortcut bar available on the desktop. 
 
Method 2: Opening a document from Word’s startup screen 
Click at the 'File' menu and select the option 'Open'  
 
Alternatively, for opening a document, just double-click at the 'Open' button from the 
standard toolbar.  This icon looks exactly similar to a file folder. 
 
One very important thing to observe here is that - an 'Open' dialog box appears on the 
screen after employing any of the above mentioned methods of opening a document.  In 
this 'Open' dialog box you would notice a 'look in' box which is used for selecting the drive 
as well as the folder where your required document is resident in.  Then, there is 'Files of 
Type' box which helps you to select the kind of file that you want to open.  Suppose you 
want that only the WORD documents should be shown in the file list, then click at the pull 
down arrow and from the drop down list, select 'Word Documents' option.  In case you 
want to see all the files in the selected drive, then select 'All Files' option from the drop 
down list.  Finally click the filename in the file list and click at the <Open> button or 
double click the filename to open up the file. 
 
Creating a New Document  

1. Click on File  
2. Select New  

o To create a blank document, simply select Blank Document. To create a 
document based on one of the templates provided in Microsoft Word, select 
which one you would like to create and select OK  

Saving a document 
For future retrieval of the document, it needs to be saved on hard disk or floppy disk.  Once 
all the text is entered, save the document with any of the following methods: 
 
Method 1: Click at the 'File' menu and then select 'Save' option.   When the file is being 
saved for the very first time, the 'Save as' dialog box comes up because WORD needs some 
additional information from you. 
 
Firstly, WORD wants you to give a name to your file.  This has to be given in the 
'Filename' box.  Secondly, the kind of file you are trying to save, should be given in the 
'Save as type' box.  Thirdly, the place where you want to save your document should be 
given in the 'Save in' box.  After giving all this information, click at the <Save> button.  
Your file is finally saved onto the disk. 

 
The 'Save as' dialog box is displayed only once till the time you don't give a name to your 
document.  Once the document has a name, next time if you try to save your file after 
making a few changes in it, then the 'Save as' dialog box will not appear on the screen. 
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Bullets and Numbering: It is always advisable to put the text entries, which are separated 
by commas in the bulleted or the numbered form.  Adding bullets to the text makes it easy 
to read and understand.  Major points can be very well emphasized through this technique.  
Points put in the order of preference are long remembered by the reader.   
 
Moreover, in our day to day life, we prefer to make our daily list in the numbered manner 
rather than putting it in a paragraph.  The only idea is that the chances of forgetting are 
turned low and visibility of important points is clearer.  You can put bullets or numbers in 
an existing list by using either the formatting toolbar or the 'Format' menu. 
 
Using Formatting Toolbar 
1. Select the text. 
2. Click at either the 'Bullets' button or the 'Numbers' button on the formatting toolbar. 
 
In case you decide that you don't require 'numbers' or ‘bullets’, you can very easily put 
them off by repeating the above steps. This method perhaps offers a wider choice of 
symbols other than the typical black circle.  Let us discuss this method: 
 
1. Select the text. 
2. Select the 'Format-Bullets and Numbering' option. 
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Table Properties 
Use the Table Properties dialog box to modify the alignment of the table with the body 
text and the text within the table. Access the box by selecting Tables|Table Properties. 
 

 
 

 Size - Check the Preferred width box and enter a value if the table should be an 
exact width.  

 Alignment - Highlight the illustration that represents the alignment of the table in 
relation to the text of the document.  

 Text wrapping - Highlight "None" if the table should appear on a separate line 
from the text or choose "Around" if the text should wrap around the table.  

 Borders and Shading - Select from a number of border styles, colors, and widths. 
Click the Shading tab to change the background color and pattern. 
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5. Click on the image you want to insert.  A shortcut menu appears.  This little 

shortcut menu can be a valuable tool - see the explanations in the graphic below. 

 
The last tool, which finds clipart that is similar, can be great if you need more than one clip 
to insert with the same theme or if you like the look of one and want to see other clipart 
with the same artistic effect. 

 
6. Once you are sure have located the right clip, click and choose the Insert Clip 

button or right-click on the clip and choose Insert Clip. 
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This same toolbar is used when you insert a picture from a file - like a family photo.  If you 
crop a picture, you cut out part of the picture along one of the sides.  So, let's pretend our 
clipart is a family photo and cut out our mother-in-law!   

1. Choose the Crop tool, as above. 
2. Move your mouse over one of the top, bottom, or side nodes.  The crop tool appears 

along with your mouse. 
3. Hold the mouse button down and drag to crop.  Note that you can also press the Alt 

key here while dragging for greater control. 

 
Other useful Picture toolbar tools: 
If tools or selection options are grayed out, it is because the tool is only available when 
inserting a picture file such as a JPEG or GIF. 

 The first button on the toolbar inserts a picture from a file into your document.  You 
will not use this tool when working with clipart. 

 The second tool is Image Control.  You can use this tool to grayscale your clipart 
or make it black and white.  We'll discuss a watermark later on. 

 
 Following image control, are buttons that can be used to increase or decrease the 

contrast and brightness of the clipart. 
 The Text Wrapping tool tells word how you want to treat text that surrounds the 

clipart.  For example, you might want to type text over the clipart and use it as a 
background. 
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8. Move your insertion point and type text as you would in any document. 

 
When you choose to have Behind text as the layout, you are allowed to move the image 
around on your screen.  In this case, we want to move the image down and a bit to the right. 

9. Select the image.  Move your mouse to the middle of the image, hold the button 
down, and drag the clipart to the proper location.  Remember, you can press and 
hold the Alt key for more precise movement. 

 
Voila!  We're finished.  Clipart can be an amazing addition to your documents.  It takes a 
little time and practice, but is well worth the effort! 

 
7.1.8 Inserting Page Numbers and Date/Time  
 

1. Click Insert at top of screen  
2. Select Page Numbers and/or Date & Time  
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The macro will be saved and you can run it by clicking the run macro command (or Alt-F8) 
from the Tools menu. 

 

Before the macro run: 

 

After the macro run: 

 

 

Now that you know how to make macros by recording keystrokes and mouse clicks, apply 
this tip on your own repeated tasks.  This will increase your productivity and also you 
quality of work. 
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Click in the appropriate place in the document that you want to insert Merge Fields.  
From the Mail Merge toolbar Click "Insert Merge Field" and Click the Merge Field to 
insert into the document. The Merge Field will appear as "<<Company>>" in the 
document. 
 
Click "ABC" to view the document with the merged data. 
 
Click "Mail Merge Helper" button on the Mail Merge Toolbar. 
 
Step 3: 
 
Click Merge on the Mail Merge Helper screen.  

 

 
 

On the next screen Click Merge. 
 

Separate documents with the Merge Fields replaced by the actual contact details will be 
created. 
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The fax will be sent when "Fax only" or "Fax and Print" is clicked. To view the status of 
the faxes being sent, go to Fax Console. (Click Start > All Programs > Accessories > 
Communications > Fax > Fax Console). 
The Fax Merge is completed and multiple faxes are sent with just a few clicks. 
 
7.2.5 Create a Template 
Templates are a special type of Word document that can hold text, styles, macros, keyboard 
shortcuts, custom toolbars and AutoText entries. A document created using a template will 
have access to all of these features and a large part of your job in creating a new document 
will be done for you if your templates are well thought out. You don't need to use all (or 
even any) of these features for templates to help you and those with whom you work. 
 
Using Templates 

• A template sets what text, formatting and graphics will automatically appear in the 
new document. The template is a base pattern of content for a document. 

• Templates can be created for expense reports, status reports — any document that 
is used repetitively. 

• Templates not only save you time, they allow for a custom editing environment, 
store tools to edit a document effectively, store Styles, store automated macro 
procedures, and store AutoText boilerplate 

 
Accessing Library Templates 
 

 The built-in Template Library gives you access to more than 40 preset templates 
from within Word. 

 From the main menu, choose File > New to open the New Document pane, and 
click on General Templates to open the Templates dialog box: 

 
To select a Template from the Templates dialog box: 

 From the main menu, choose File > New to open the New Document panel 

 Click on General Templates to open the Templates dialog box. 

 Select the required template. The Preview area will show a thumbnail image of the 
template. 

 Select the Template option in the Create New options area. 

 This will create the item as a template rather than a one-time document. 

 Click OK. 

 The new template will open. Make any adjustments if needed, and save with a 
different name under a different folder. 
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Modifying a Template 
 

 The templates in the Template Library and on the Microsoft.com Website cannot 
be altered until they have been saved in an alternate folder on the hard drive with a 
different name. 

 Once saved, open the template, and make any alterations required. 
 
To save a modified Template: 

 From the main menu, choose File > Save As to save the template as a template file. 

 Confirm that Document Template is selected in the Save as type field. 

 Once all selections are set and confirmed, click Save. 
 The various template tabs allow you to select and use templates to create Letters, 

Faxes and Memos, do a Mail Merge, etc. 

 Most of the templates have built-in directions that cover where to enter information 
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Delete Data 
The Backspace key erases one character at a time.  

1. Press the Backspace key until Jordan is erased.  
2. Press Enter. The name "John" appears in cell A1.  

 
Edit a Cell 
After you enter data into a cell, you can edit the data by pressing F2 while you are in the 
cell you wish to edit. 

 
 
 
Alternate Method: Editing a Cell by Using the Formula Bar 
You can also edit the cell by using the Formula bar. You change "Jones" to "Joker" in the 
following exercise. 

 
 

1. Move the cursor to cell A1.  
2. Click in the formula area of the Formula bar.  
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4. Use the Backspace key to erase "r," "e," and "k."  
5. Type hnson. 
6. Press Enter.  

 
Change a Cell Entry 
Typing in a cell replaces the old cell entry with the new information you type. 

1. Move the cursor to cell A1.  
2. Type Cathy.  
3. Press Enter. The name "Cathy" replaces "Johnson."  
 

 
 
Wrap Text 
When you type text that is too long to fit in the cell, the text overlaps the next cell. If you 
do not want it to overlap the next cell, you can wrap the text. 
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EXERCISE: 
Wrap Text 
  

 
 

1. Move to cell A2.  
2. Type Text too long to fit.  
3. Press Enter.  
 

 
 

4. Return to cell A2.  
5. Choose the Home tab.  
6. Click the Wrap Text button . Excel wraps the text in the cell.  

 
Delete a Cell Entry 
To delete an entry in a cell or a group of cells, you place the cursor in the cell or select the 
group of cells and press Delete. 
 
EXERCISE: 
Delete a Cell Entry 

1. Select cells A1 to A2.  
2. Press the Delete key.  
3. Save a File 
4. This is the end of Lesson1. To save your file: 
5. Click the Office button. A menu appears.  
6. Click Save. The Save As dialog box appears.  
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Sorting with Custom Lists 
Next, consider an example that illustrates how to sort on a custom list of values. Assume 
you have a table with a column of modes of transportation. 
 

 
 

Figure 7.28 Column of text values 
 

First, in the Sort dialog box, specify the column name and then, in the Order list, select 
Custom List. Click OK. 
 

 
 

Figure 7.29 Select Custom List in the Order drop-down 
 
In the Custom List dialog box, select NEW LIST and then type in the data values 
separated by commas. Click OK when you are finished. 
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Figure 7.30 Resulting table after sorting on a custom list 
 
The table is now sorted by the custom list of values you specified. 
 

 
 

Figure 7.31 Sorted column 
Conclusion: The ability to sort up to 64 columns of data gives you greater control over 
how your data appears. Likewise, sorting by cell color or font color enables you to put the 
data that is important to you at the top of the table column or a range. The ability to sort 
user-defined lists of values allows you to customize tables in a way that is relevant to your 
needs. 
 
-------------------------------------------------------------------------------------------------------------- 
7.5 MS-EXCEL-III 
-------------------------------------------------------------------------------------------------------------- 
7.5.1 Graphs and Charts: A graph is a chart or drawing that shows the relationship 
between changing things. They are a diagram displaying the relationship between numbers 
or amounts. Common graphs use bars, lines, or parts of a circle to display data. Below are 
the steps given to insert Graphs and charts. They are: 
Step 1 - Enter the data to be graphed. For the purpose of this lesson you will use data from 
a Favorite Fruit Survey. Enter it as you see below: 
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After you have selected the Chart type, click and hold your mouse pointer down on the 
Press and Hold... button to see what your data looks like in the chart type you selected. If 
you do not like the look, select another chart type. After you have selected the chart type 
you will have two options: 

• Select Next and let Chart Wizard show you a series of options to make changes to 
your chart.  

• Select Finish and Chart Wizard puts your completed chart on the spreadsheet. You 
can see the finished product below.  

 
The first step taken by Chart Wizard is to verify the range of data being used for this chart. 
The Data range displayed below is read "all cells from A2 to B7." 
 

 
 
Notice where the cursor is located in the dialog box above. It is pointing to the small box at 
the end of the line where the Data range is displayed. If the data range should be changed, 
click on the box the cursor is pointing to. 
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specific type of slide. They provide consistency throughout the presentation. Each layout 
depicted is described in the lower right corner when you click the layout. This sample New 
Slide dialog box shows the Title Slide selected (denoted with the thick border).  
 

 
 
After you select Blank Presentation a window pops up asking you to select the layout of the 
first slide.  
 
Pre-Designed Slide Layouts (Left to Right)  

• Title Slide  
• Bulleted List  
• Two Column Text  
• Table  
• Text & Chart  
• Chart & Text  
• Organizational Chart  
• Chart  
• Text & Clip Art  
• Clip Art & Text  
• Title Only  
• Blank Slide  

 
NOTE: If you already know what you want in your next slide, it is a very good idea to 
choose one of the pre-designed layouts from above. However if you do not, then you 
can still insert what you want in throughout your Presentation anytime you desire. 
Just choose Blank Slide and insert items as you see fit.  
 
Different Views That PowerPoint Demonstrates:  
There are different views within Microsoft PowerPoint that allow you to look at your 
presentation from different perspectives.  
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9.1.4 Exploring Inbox 
Electronic mail, or e-mail, is quickly becoming one of the most widely used forms of 
communication in the world. It is fast, convenient, and doesn't require a stamp. Using e-
mail, you can send a simple text message, like a reminder about an assignment or you can 
send a message that includes other files, such as a grade report spreadsheet or graphic file. 
With a microphone, you can even send voice messages. 
 
Using e-mail can be beneficial for students and enhance instruction in many ways, from 
making it easier to ask questions to providing a forum for out-of-class discussions and 
collaboration. It can provide meaningful contact outside the classroom with instructors and 
peers. E-mail is easy to use and is becoming more and more accessible to students through 
their home computers or an information appliance like Microsoft Web TV. A few minutes 
of instruction can get most students (and instructors) up and running with e-mail. 
 
  
 
  
 
  
  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Inbox symbols: 

 
High importance 
message 
 

 
Low importance 
message 
 

 
Read message 
 

 
Unread message 
 

 
Forwarded message 
 

 
Replied to message 
 

 
Saved or unsent 
message 
 

 
Sealed message 
 

 
Digitally signed 
message 

More Inbox symbols: 

 
Accepted meeting request 
 

 
Tentatively accepted meeting 
request 
 

 
Declined meeting request 
 

 
Canceled meeting 
 

 
Task request 
 

 
Accepted task 
 

 
Declined task 
 

 
Message is flagged for follow 
up 
 

 
Message is flagged as 
complete 
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Exploring Contacts 
 
Outlook 2000 serves as much more than just an e-mail program: you can use it to maintain 
an electronic address book of your students, colleagues, and anyone else you need to 
contact. Storing contacts electronically in Outlook 2000 allows you to find information 
about someone quickly and easily. In the Contacts folder, you can store a wide range of 
information about people, from their work and home phone numbers and physical 
addresses to e-mail addresses and Web addresses, if they have them. You can link any 
Outlook item or Office document to a contact to help you track activities associated with 
that person or group. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When you enter a name or address for a contact, Outlook 2000 separates the name or 
address into parts and puts each part in a separate field. You can sort, group, or filter 
contacts by any part of the name or any part of the address you want. 
 
From a contact in your contact list, you can click a button or menu command to have 
Outlook 2000 address a meeting request, e-mail message, or task request to the contact. If 
you have a modem, you can also have Outlook 2000 dial the contact's phone number. You 
can have Outlook 2000 time the call and keep a record in Journal complete with the notes 
you take during the conversation. 
 
 
 
 
 
 

Contacts symbols: 

 Activities have 
been 
automatically 
recorded in 
Journal for this 
contact 
 

 Contact 
 

 Contact has an 
attachment 
 

 Contact is flagged 
for follow up 
 

 Contact is flagged 
as complete 
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To set calendar preferences 
With the Calendar folder open, on the Tools menu, click Options. The Options dialog box 
opens. 
 

• Click the Preferences tab.  
• Under Calendar, select Default reminder to have Outlook 2000 remind you 

automatically of all appointments. Then, in the drop-down box, select the amount of 
time before appointments you want to receive the reminder. (You can change this 
time for individual appointments when you create them.) 

• Click Calendar Options. The Calendar Options dialog box opens. 
 

 

Calendar symbols: 

 
Appointment 
 

 Click to see calendar 
items that do not fit in 
the current view 
 

 
Meeting 
 

 
Meeting request 
 

 
Recurring 
appointment 
 

 
Recurring meeting 
 

 
Recurring meeting or 
appointment 
 

 
Reminder for the 
appointment or 
meeting 
 

 
Private meeting or 
appointment 
 

 

Start and end times 
of the appointment or 
meeting 
 

 
Calendar item has an 
attachment 
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system, the Microsoft Windows 2000 
operating systems, and Microsoft Office 
98 for the Macintosh. Outlook Express is 
designed for home users who gain access 
to their e-mail messages by dialing in to 
an Internet service provider (ISP). 

integration with Internet Explorer 
5.5. Complete integration of e-mail, 
calendaring, and contact 
management, makes Outlook the 
perfect client for many business 
users 

Technology Built on open Internet standards, Outlook 
Express is designed for use with any 
Internet standard system, for example, 
Simple Mail Transfer Protocol (SMTP), 
Post Office Protocol 3 (POP3), and 
Internet Mail Access Protocol (IMAP). It 
provides full support for today's most 
important e-mail, news, and directory 
standards such as Lightweight Directory 
Access Protocol (LDAP), Multipurpose 
Internet Mail Extension Hypertext 
Markup Language (MHTML), Hypertext 
Markup Language (HTML), 
Secure/Multipurpose Internet Mail 
Extensions (S/MIME), and Network 
News Transfer Protocol (NNTP). Full 
support ensures that you can take 
advantage of new technologies as well as 
seamlessly send and receive e-mail 

Outlook is designed for use with 
the Internet (SMTP, POP3, and 
IMAP4), Exchange Server, or any 
other standards-based 
communication system that 
supports Messaging Application 
Programming Interface (MAPI), 
including voice mail. Outlook is 
based on Internet standards and 
supports today's most important e-
mail, news, and directory standards, 
including LDAP, MHTML, NNTP, 
MIME, and S/MIME, vCalendar, 
vCard, iCalendar, and full support 
for HTML mail. Outlook also 
offers the same import tools that are 
offered with Outlook Express. This 
enables easy migration from other 
e-mail clients, and offers further 
migration from Microsoft Mail, 
Microsoft Schedule+ 1.0, Microsoft 
Schedule+ 7.0, Lotus Organizer, 
NetManage ECCO, Starfish 
SideKick, Symantec ACT, as well 
as synchronization with leading 
Personal Digital Assistants (PDAs), 
such as the 3Com Palm Pilot. 

Platforms 
Supported 

Versions of Windows later than 
Microsoft Windows 95, versions of 
Windows earlier than Microsoft 
Windows 95, Macintosh, and UNIX 
platforms 

Versions of Windows later than 
Microsoft Windows 95, versions of 
Windows earlier than Microsoft 
Windows 95, and Macintosh 
platforms 

Calendars, 
group 
scheduling, task, 
and contact 
management 

Not Supported Supported By Outlook and is 
widely used across organizations 
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People 
Although it takes people to complete work, it is the way people work that accounts for 
productivity. In recent years, the trend has been towards people working together to 
accomplish more. This is called work-group computing, which means a number of 
knowledge workers, each with different tasks, jobs or duties, work together towards a 
common goal. In large companies, there may be dozens or hundreds of workgroups. In 
smaller companies, everyone is part of the workgroup.  
 
Ergonomics 
Business learned that "office could not be automated in the same way the factory was 
automated, and the field of ergonomic began to emerge. Office tasks involve a great deal of 
thinking and decision-making. As a result office systems must be flexible and versatile. 
Moreover, they must be deigned so any knowledge worker, regardless of background can 
easily use them. This is called ergonomics, the study of how to create safety, comfort and 
ease of use for people who use machines. It is not a new field of study; in fact it has existed 
for over 100 years.    
 
With the advent of computers, ergonomics engineers became particularly interested in 
office automation systems, furniture "and. environments for the knowledge worker 
intensive studies determined the best ,designs for Keyboard, set. Eyes fatigue- levels for 
monitors, and specified desks and seating designs that alleviate physical stress. Office 
furniture companies soon introduced ergonomically designed chairs and "equipment. 
Ergonomics has- played a significant role in -helping people use technology more 
effectively 
 
There are five primary technologies used in managing information in office automation: 
 

• Text or written words  
• Data, as in umbers or other non-text forms. 
• Graphics, including drawings, charts and photographs  
• Audio, as in telephone, voice mail, or voice recognition  systems 
• Video, such as captured images, videotapes or teleconferencing.  

 
In the past these forms of information- was created using different technologies. Text was 
created using conventional typewriters' or more" recently, word processing. 
 
9.3.1 Office Automation Technologies 
Data, such as sales reports, was provided by the central computer. Charts and grabs were,-
either l1and-drawn or created using 35mm slide photography and videotapes were user” or 
training. Audio was limited t9 the" phone or tape recording. It was not possible to combine 
these various forms of information. 
 
What made it Possible to combine them was the computer. What computer produces is 
called an electronic document, which is a self-contained work, conveying information that 
has been created by a knowledge worker and stored in a computer system. An electronic 
document may be a simple main that may be printed on paper or transmitted via electronic 
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mail. Or it may be a more complex document, with graphics or even Video. Most computer 
'systems can incorporate sound, so that an onscreen document can be annotated with 
comments spoken by the document creator. 
 
Today, the computer integrates others different media and others' as well Data, sound and 
images can all -be 'entered info' a computer-, stored- and translated into the kind of output 
we need. It is now common to seek knowledge worker’s in workgroups using a special type 
of, software designed' specifically for them and their work. This application software’s 
called groupware, lets networked PCs and workstations share information and electronic 
documents from both corporate and on-line sources. At the center of this integration are 
networking and communications systems... 
 
Office Automation Systems 
Office automation uses computer based systems to provide" information to help knowledge 
workers make decisions that benefit the business. Office automation systems are" 
comprised of many distinct subsystems: text management systems, business analysis 
systems, document management systems" and Network and communications C systems. 
 
Text Management Systems 
A text management system is a completer system -c1esigned to work with the written or 
typewritten word. It includes all kinds of typewriters, word processing systems, PCs with 
word processing, desktop publishing and text editing systems, and even computerized 
typesetting equipment. Text management systems are used for test like writing memos, 
notes, letters and other short documents, - printing envelopes" and labels preparing pre-
printed forms such as invoices, composing complex documents such as proposals and 
reports, retrieving and editing documents such as contracts, Creating display documents 
like newsletters, etc. 
 
Business Analysis Systems  
Managers need solid data from which to extract the information necessary to make good 
decisions for the business. In the past, these knowledge workers had to rely on their 
experience and other personal factors to make decisions. A business analysis system 
provides data that, when used with the proper software, helps its users - better understand 
the business environment and make more effective decisions. Corporate users routinely use 
spreadsheets for analyzing cost and benefits and for creating budgets. 
 
Other software tools for performing analysis that and"-.commonly used in large companies 
are decision support systems (DSS), expert systems and executive support \ systems (ESS). 
A decision support system helps the knowledge worker to extract information from the 
various MIS database and reporting systems, analyze it, and then formulate a decision or a 
strategy for business planning. An expert system is a computer system that can. store and 
retrieve data with special problem solving expertise. An executive support system is an 
information system that consolidates and summarizes ongoing transactions within the 
organization. It provides the management with all the information it requires at all times 
from internal as well as external sources. 
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